
Design Guide: TIDA-010090
4 チャネル、50A、デジタル制御バッテリ セル テスタのリファレンス 
デザイン

概要

このリファレンス デザインでは、C2000™ マイクロコントロ

ーラ (MCU) と高精度 ADC ADS8588S を使用して、双

方向降圧コンバータ電力段の電流と電圧を正確に制御す
る方法を紹介します。このデザインは、C2000 MCU の高

分解能パルス幅変調 (PWM) 生成ペリフェラルを活用し

て、±10mA 未満の電流レギュレーション誤差と ±1mV の
電圧レギュレーション誤差を実現しています。

リソース
TIDA-010090 デザイン フォルダ

LMG3100R017、INA241 プロダクト フォルダ

TMS320F28P650DK、REF54 プロダクト フォルダ

ADS8588S、TPSI3050、TVS0500 プロダクト フォルダ

TPS7A20、TLV1117、LM2664、TPS736 プロダクト フォルダ

TMDSCNCD28P65X ツール フォルダ

C2000WARE-DIGITALPOWER-SDK ツール フォルダ

テキサス・インスツルメンツの™ E2E サポ

ート エキスパートにお問い合わせくださ

い。

特長

• 4 チャネル、双方向降圧電力段

• 400kHz のスイッチング周波数

• 閉ループ制御向け外部 16 ビット SAR ADC
• レギュレーション誤差 ±10mA 未満の定電流充放電

• レギュレーション誤差は ±1mV 未満で、充電と放電の

両方で定電圧モードに対応
• ソフトウェア周波数応答アナライザ (SFRA) および補

償デザイナにより、制御ループを簡単に調整可能
• ユーザー要件に応じた設計の適用を容易にする 

powerSUITE をサポート

アプリケーション

• バッテリ セル形成とテスト機器

• プログラマブル DC 電源
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1 システムの説明

バッテリ テスタ装置には、シングル セル、バッテリ モジュール、および高電圧バッテリ パックのテストに使用されるさまざま

な装置が含まれています。この試験装置は、高精度の電源とデータ収集システムを搭載しており、バッテリの充電と放電
に使用され、セルのさまざまなパラメータを測定します。

図 1-1 に、リチウムイオン バッテリを簡略化した製造プロセスを示します。最終段である、エンドオブライン コンディショニ

ングには、セル形成とテストが含まれます。形成はリチウムイオン電池の製造において重要なステップです。形成中、セル
は最初の充電と放電のプロセスを経て、固体電解質界面 (SEI) 層が形成されます。SEI 層の品質は、バッテリ セルの容

量と信頼性に影響を及ぼします。形成プロセスを制御するために、セルの充電と放電に高精度のプログラマブル電源が
使用されます。これらの電源は、バッテリ形成システムまたはバッテリ テスタと呼ばれます。バッテリ テスタに必要な電圧お

よび電流の精度は、通常、フルスケールの ±0.02%～±0.05% の範囲内です。
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図 1-1. リチウムイオン バッテリの製造プロセスの簡素化

1.1 主なシステム仕様

パラメータ 仕様

LV ポート – バッテリ ポート 50mV～6V

HV ポート – バス電圧 12V～15V

最大出力電流

(ヒートシンクなし) ±20A

最大出力電流

(ヒートシンクあり) ±50A

チャネル数 4

スイッチング周波数 400 kHz

制御ループのサンプル レート 50kSPS

電流レギュレーション誤差 ±10mA (0.02% FS) 未満

電圧レギュレーション誤差 ±1mV (0.02% FS) 未満
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2 システム概要

2.1 ブロック図

図 2-1 に、リファレンス デザインのブロック図を示します。TMS320F28P650DK MCU は、同期整流降圧電力段用の高

分解能 PWM を生成し、電流および電圧制御機能を実行します。INA241 電流センス アンプがバッテリ電流を検出し、

OPA2186 オペアンプがバッテリ電圧を検出します。電流および電圧信号は、外部の ADS8588S ADC によってデジタ

ル データに変換されます。C2000 オンチップ ウィンドウ コンパレータを使用して、過電流保護機能を実装しています。
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図 2-1. TIDA-010090 のブロック図

2.2 設計上の考慮事項

2.2.1 電流および電圧コントローラ

電流および電圧制御ループのソフトウェア実装を、図 2-2 に示します。電圧ループを電流にカスケード接続することで、

充電モードと放電モードで定電流と定電圧の両方を実現します。バッテリ電圧が定電圧設定 (VSET) から離れている場

合、電圧ループが定電流設定 (ISET) に飽和します。バッテリ電圧が VSET に近い値に達すると、電圧ループが閉じら

れ、ISET が低下して、バッテリ電圧が VSET 制限を超えないようにします。コントローラは充電モードと放電モードの両方

で動作します。充電モードでは、VSET によって最大バッテリ電圧が制限されるため、充電が停止します。放電モードで

は、VSET によって放電が停止する最小バッテリ電圧が制限されます。
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図 2-2. 電流および電圧コントローラ

2.2.2 DC/DC のスタートアップ

バッテリの充電と放電には、双方向電力段が使用されます。通常のスタートアップ条件では、降圧コンバータの出力が 0V 
から目標電圧に増加します。降圧コンバータが 0V から上昇している間にバッテリ負荷が接続されると、大電流オーバー

シュートが発生する可能性があります。この問題は、2 つの方法で回避できます。1 つ目の方法では、図 2-3 に示すよう

に、出力リレーをオープンにして降圧コンバータを起動し、降圧コンバータがバッテリ電圧に近い値に達したときに、リレー
を閉位置に設定します。2 つ目の方法では、図 2-4 に示すように、DCM モードで降圧コンバータを起動し、充電中はロ

ーサイド スイッチをオフにし、放電中はハイサイドをオフにします。非同期モードから同期モードに切り替えるには、タイマ

が必要です。
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図 2-3. 同期スタートアップ
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図 2-4. 非同期スタートアップ

2.2.3 高分解能 PWM 生成

高分解能を生成するには、高分解能 PWM 出力機能を持つ C2000 を使用しています。高分解能カウンタは 150ps の
タイム ステップを実行でき、これは 100MHz の CPU クロックの 192kHz PWM 周波数における 15 ビットの分解能に相

当します。さまざまなスイッチング周波数での PWM 分解能を、表 2-1 に示します。

表 2-1. PWM と HRPWM の C2000™ マイコンの分解能

PWM
周波数

通常の分解能 (PWM) 高分解能 PWM
100MHz EPWMCLK

(kHz) ビット % ビット %
20 12.3 0.02 18.1 0

50 11 0.05 16.8 0.001

100 10 0.1 15.8 0.002

150 9.5 0.15 15.2 0.003

200 9 0.2 14.8 0.004

250 8.6 0.25 14.4 0.005

2.3 主な使用製品

2.3.1 TMS320F28P650DK

TMS320F28P650DK C2000 デバイスを使用して、同期整流降圧電力段を制御します。このデバイスには、18 のバッテ

リ テスト チャネルまたは降圧コンバータを制御するのに十分な 36 の HRPWM チャネルが搭載されています。

『TMS320F28P65x リアルタイム マイクロコントローラ』データシートも参照してください。

2.3.2 ADS8588S

ADS8588S は 8 チャネルの同時サンプリング、16 ビット、SAR、A/D コンバータ (ADC) で、± 0.01% の精度と 1kHz の
ループ帯域幅に十分な最大 200kSPS の最大サンプル レートを使用できます。『ADS8588S 16 ビット、高速、8 チャネ

ル同時サンプリング ADC、単一電源によるバイポーラ入力』データシートも参照してください。
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3 ハードウェア、ソフトウェア、テスト要件、テスト結果

3.1 ハードウェア要件

図 3-1 に TIDA-010090 ハードウェアを示します。TIDA-010090 基板を動作させるには TSM320F28P65X 
controlCARD 評価基板 が必要です。

図 3-1. 基板の概要

3.2 ソフトウェア要件

この設計ソフトウェアは、C2000 マイコン向けの DigitalPower ソフトウェア開発キット (SDK) (C2000WARE-
DIGITALPOWER-SDK) で供給され、powerSUITE フレームワーク内でサポートされています。

3.2.1 Code Composer Studio™ 内でプロジェクトを開く

Code Composer Studio (CCS) でプロジェクトを開始するには、次の手順に従います。

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール フォルダから Code Composer Studio をインストール

します。バージョン 12.4 またはそれ以降をお勧めします。

2. C2000WARE-DIGITALPOWER-SDK を次の 2 つのいずれかの方法でインストールします。

a. CCS にアクセスし、[View] → [Resource Explorer] をクリックします。 テキサス・インスツルメンツの Resource 
Explorer 下で C2000WARE-DIGITAL-POWER-SDK にアクセスし、[Install] ボタンをクリックします。

b. C2000Ware Digital Power SDK ツール フォルダからダウンロードします。

3. インストールが完了したら、CCS を閉じて、新しいワークスペースを開きます。CCS により自動的に powerSUITE が
検出されます。変更を有効にするために CCS を再起動しなければならない場合があります。
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注
デフォルトでは、powerSUITE は SDK のインストールと同時にインストールされます。

ファームウェア プロジェクトは、次のいずれかの方法でインポートできるようになりました。

• Resource Explorer を使用する

1. Resource Explorer の C2000WARE-DIGITAL-POWER-SDK で、[powerSUITE] → [Solution Adapter Tool] 
をクリックします。 

2. [DC-DC] セクションに表示される設計のリストから TIDA-010090 を選択します。

3. 開発キット ページが表示されます。プロジェクトを実行するためのアイコンがトップ バーに表示されます。[Run 
Project] をクリックします。

4. この操作によりプロジェクトがワークスペース環境にインポートされ、GUI が図 3-2 のような設定ページが表示され

ます。
5. この GUI ページが表示されない場合は、C2000WAREDIGITAL-POWER-SDK Resource Explorer の 

powerSUITE 下の FAQ セクションを参照してください。

• ソリューション フォルダから直接インポートする

1. CCS 内で [Project] → [Import CCS Projects] をクリックし、/solutions/tida_010090/f28p65x/ccs にあるソリュー

ション フォルダを参照して、プロジェクトを直接インポートすることもできます。

2. 2 つのプロジェクト仕様が表示されます。1 つは powerSUITE 付きで、もう 1 つは powerSUITE なしです。いず

れかをクリックすると、プロジェクトの自己完結型フォルダが作成され、その中にすべての依存関係が含まれます。
3. powerSUITE のないプロジェクトは、powerSUITE GUI の制限を見つけたお客様、または量産コードから 

powerSUITE を削除したいお客様向けに提供されています。

4. このドキュメントでは powerSUITE プロジェクトについて説明しますが、powerSUITE のないプロジェクトでも、こ

の設計ガイドに記載されている powerSUITE settings.h ファイルの関連する #defines に変更を加えること

で、すべての手順を繰り返すことができます。
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図 3-2. 設計の powerSUITE ページ

3.2.2 プロジェクト構造

プロジェクトの一般構造を、図 3-3 に示します。プロジェクトがインポートされると、図 3-4 に示すように CCS 内に Project 
Explorer が表示されます。

注
図 3-4 は F28p65x のプロジェクトを示していますが、 ページから別のデバイスを選択しても、その構造は同

様です。
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図 3-3. プロジェクト構造の概要

コア アルゴリズム コードで構成されるソリューション別およびデバイスに依存しないファイルは .c/h にあります。 

基板別でデバイス別のファイルは _hal.c/h にあります。 このファイルは、ソリューションを実行するデバイス特定のドライ

バで構成されています。別の変調方式やデバイスを使用する場合、プロジェクト内のデバイス サポート ファイルを変更す

る以外に変更を加える必要があるのは、これらのファイルのみです。

-main.c ファイルは、プロジェクトのメイン フレームワークで構成されています。 このファイルは、システム フレームワーク

の作成に役立つボード ファイルとソリューション ファイルの呼び出し、割り込みサービス ルーチン (ISR)、低速なバックグ

ラウンド タスクで構成されています。

この設計では、ソリューションは bt4ch_gan です。 

powerSUITE ページは、Project Explorer に表示される main.syscfg ファイルをクリックして開くことができます。 

powerSUITE ページでは _settings.h ファイルが生成されます。 このファイルは、powerSUITE ページで生成されたプ

ロジェクトのコンパイル時に使用する唯一の C 言語を使用したファイルです。プロジェクトが保存されるたびに 

powerSUITE によって変更内容が上書きされるため、このファイルを手動で変更しないでください。

_user_settings.h は _settings.h ファイルに含まれており、ADC マッピングの #defines や GPIO など、

powerSUITE ツールの範囲外の設定を保持するために使用できます。

_cal.h ファイルは、電流と電圧を測定するためのゲイン値とオフセット値で構成されています。

Kit.json ファイルと solution.js ファイルは、powerSUITE により内部で使用されるため、ユーザーが変更することはできま

せん。 これらのファイルを変更すると、プロジェクトが正常に機能しなくなります。

ソリューション名は、ソリューションで使用されるすべての変数のモジュール名および定義としても使用されます。したがっ
て、すべての変数および関数呼び出しの先頭には BT4CH 名が付きます (たとえば、BT4CH_userParam_chX)。 この

命名規則により、名前の競合を回避しながら、異なるソリューションを組み合わせることができます。
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図 3-4. BT4PH プロジェクトの [Project Explorer] ビュー

bt4ch_gan プロジェクトは 3 つの ISR (ISR1、ISR2、および ISR3) で構成されています。

降圧コンバータの入力電源と出力コンデンサ電圧を検出するには、ISR1 を使用します。ISR1 は、ADCC 変換完了によ

ってトリガされます。ADCC はコンバータの入力電圧と出力電圧を検出し、その出力は DC/DC のソフトスタートの実装に

使用されます。

ISR2 は、ADS8588S の BUSY 信号によってトリガされます。外部 ADC は 50kSPS のサンプル レートにプログラムさ

れ、これによって ISR 周波数が設定されます。

ISR3 は、SPI 受信 FIFO 割り込みによってトリガされます。ISR を使用して、FIFO レジスタから外部 ADC データを読み

出し、制御ループ関数を実行します。

図 3-5 に、4 つのチャネルすべてがオンの場合の ISR1、ISR2、ISR3 の所要時間を示します。3 つの ISR に要する合

計時間は 6μs 未満となり、これは 50kSPS 制御ループのサンプル レートでは、CPU 使用率の 30% 未満です。図 3-6 
および図 3-7 に、1 つのチャネルのみがオンですべてのチャネルがオフのときの ISR 時間を示します。
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図 3-5. 4 チャネルの ISR 実行時間

図 3-6. 1 チャネルの ISR 実行時間

図 3-7. すべてのチャネルがオフのときの ISR 実行時間
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3.2.3 ソフトウェア フロー図

bt4ch_gan_hal.c/h,  ads8588s.h, and bt4ch_gan_cal.h files are necessary to run the bt4ch_main.c and bt4ch.h/c

main()

//Psuedo code

//Setup device, init interrupt, cputimer

//Setup analogpinmux

// Setup internal ADC

//Setup clock for external ADC

//Setup HRPWM for the power stage

//Enable phase shift

//Configure comparators for overcurrent protection

//Setup SFRA

//Setup SPI for external ADC

//Configure external ADC

//Initial variables used in the program

//Enable interrupts

//Configure output relay

bt4ch_gan_main.c

Background Loop

A1-> BT4CH_updateEnable(..),BT4CH_updateReference()

A2-> BT4CH_SFRA_GUI_RUN_COMMS

A3->BT4CH_updateHrpwmMepScaleFactor();

B1->BT4CH_monitorIoutVout();

B2->BT4CH_SFRA_RUN_BACKGROUND();

B3-> BT4CH_HAL_enableRelay

C1-> BT4CH_HAL_toggleRunLed

ISR1

Restore Context Return

BT4CH_HAL_storedata_VSENSE()

ISR2

Restore Context Return

BT4CH_HAL_ExtAdcSendTxFrame();

ISR3

Restore Context Return

BT4CH_HAL_ExtAdcRead();

BT4CH_runPwmIsr();

bt4ch_gan.h

Definition of all global variables for the

solution module

BT4CH_initUserVariables();

…

BT4CH_setControlCoeffcients();

…

BT4CH_setupSfraGui();

…

BT4CH_updateEnable();

BT4CH_updateEnable();

BT4CH_updateReference();

Declaration of all global variables for the

solution module

BT4CH_dcmStartup();

BT4CH_controlCC();

BT4CH_controlCV();

BT4CH_storedataExtAdc();

BT4CH_updateHrpwmMepScaleFactor();

bt4ch_gan.c

Return

BT4CH_storedataExtAdc();

…

BT4CH_controlCC();

….

BT4CH_controlCV();

…

BT4CH_runPwmIsr()

図 3-8. ソフトウェア フロー図
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3.3 テスト構成

3.3.1 電流および電圧ループをチューニングするためのハードウェア設定

TIDA-010090

HV 

Port

LV 

Port

Output shorted with a 

cable of resistance nearly 

equal to battery
DC Source

図 3-9. 電流および電圧ループをチューニングするためのハードウェア設定

3.3.2 双方向の電力フローをテストするためのハードウェア設定

TIDA-010090

DC Source

E-load

CC Mode

DC Source

0V to 5V

E-load

CC Mode

HV  

Port

Battery 

Port

図 3-10. 双方向の電力フローをテストするためのハードウェア設定

3.3.3 電流および電圧キャリブレーションのハードウェア設定

TIDA-BOARD

DC Source

12 V to 15 V

E-load

CC Mode

12-V Bus Battery Port

6 ½ Digit DMM

Current Measurement

6 ½ Digit DMM

Voltage Measurement

図 3-11. 電流および電圧キャリブレーションのハードウェア設定
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3.4 テスト方法

3.4.1 ラボ変数の定義

BT4CH_userParam_ch1,2,3,4 変数は、さまざまなラボで電力段を制御するために使用します。パラメータの定義に

ついては、表 3-1 を参照してください。

表 3-1. BT4CH_userParam_chX 定義

BT4CH_userParam_chX データの種類 備考

Iref_A フローティング 充電モードと放電モードの両方の電流を設定 [0、100]

VrefCharge_V フローティング 充電モードで電圧を設定 [0、5]

VrefDischarge_V フローティング 放電モードで電圧を設定 [0、5]

Dir_bool 符号なし整数
充電モードの場合、このパラメータを 1 に設定します

放電モードの場合、このパラメータを 0 に設定します

Relay_ON 符号なし整数 リレーをイネーブルにする場合、このパラメータを 1 に設定します

En_bool 符号なし整数 チャネルをイネーブルにする場合、このパラメータを 1 に設定します

remote_sense 符号なし整数 閉ループ制御にリモート センスを使用する場合、このパラメータを 1 に設定します

DutyRef_pu フローティング 開ループ モードの基準デューティ サイクル範囲 = 0～1.0

IbatCal_pu フローティング
キャリブレーション モードで出力電流を設定するには、このパラメータを使用します。範

囲 = 0～1.0

VbatCal_pu フローティング
キャリブレーション モードで出力電圧を設定するには、このパラメータを使用します。範

囲 = 0～1.0

IoutGain_pu フローティング 変数には、電流ゲインのキャリブレーション データが格納されます

IoutOffset_pu フローティング 変数には、バッテリ電流オフセットのキャリブレーション データが格納されます

IoutGain_A フローティング 変数には、バッテリ電流ゲインのキャリブレーション データが格納されます

IoutOffset_A フローティング 変数には、バッテリ電流オフセットのキャリブレーション データが格納されます

VoutGain_pu フローティング
この変数には、バッテリ降圧コンバータの出力電圧ゲインのキャリブレーション データが

格納されます

VoutOffset_pu フローティング
この変数には、降圧コンバータの出力電圧オフセットのキャリブレーション データが格納

されます

VoutGain_V フローティング
この変数には、降圧コンバータの出力電圧オフセットのキャリブレーション データが格納

されます

VoutOffset_V フローティング
この変数には、降圧コンバータの出力電圧オフセットのキャリブレーション データが格納

されます

VbatGain_pu フローティング 変数には、バッテリ電圧のキャリブレーション データが格納されます

VbatOffset_pu フローティング 変数には、バッテリ電圧オフセットのキャリブレーション データが格納されます

VbatGain_V フローティング 変数には、バッテリ電圧ゲインのキャリブレーション データが格納されます

VbatOffset_V フローティング 変数には、バッテリ電圧オフセットのキャリブレーション データが格納されます

3.4.2 ラボ 1.開ループ電流制御単相

3.4.2.1 ラボ 1 のソフトウェア オプションの設定

1. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 2 に進み

ます。それ以外の場合は手順 3 に進みます。

2. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 1: Open Loop CC Single Channel] を選択します。
• 4 つのチャネルのいずれかを選択します。

• SFRA をイネーブルにします。

• ページを保存します。
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3. powerSuite のないバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで直接変

更されます。 

#define LAB_NUMBER (1)
#define CHANNEL_NUMBER (1)
#define SFRA_ENABLED (true)

図 3-12. ラボ 1 のビルド オプション

3.4.2.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

プロジェクトをビルドおよびロードし、デバッグ環境を設定するには、次の手順を実行します。

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 
2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. [Run] → [Debug] をクリックしてデバッグ セッションを開始します。

5. するとプロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_chX.js スクリプト ファイルを参照します。 これにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効

にします。 

3.4.2.3 コードの実行

ラボ 1 のコードを実行するには、次の手順に従います。

1. 図 3-9 に示すようにテスト設定を使用します。
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2. メニュー バーの をクリックしてプロジェクトを実行します。

3. [Watch] ビューの [Expression] ウィンドウで BT4H_InputVoltageSense_V が 12V～15V の範囲内にあるかどうか

を確認します。

4. オシロスコープを使用して、周波数が 50kHz の場合に外部 ADC の BUSY 信号をチェックします。MCU が動作して

いるときの ADS8588S の BUSY および CONVST 信号を、図 3-13 に示します。

5. [Expression] ウィンドウで次のパラメータを設定します。

• BT4CH_userParam_chX->dutyRef_pu を 0.06 に設定します

• BT4CH_userParam_chX->en_bool を 1 に設定します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• [Expression] ウィンドウの設定については、図 3-14 を参照してください。

6. BT4CH_measure_V_I_chX 変数は、DC/DC コンバータの出力電流と電圧を示します。

BT4CH_userParam_chX->DutyRef_pu を調整し、電流が約 15A であることを確認します。

7. 図 3-15 に、開ループ電流制御用のプラント モデルを抽出するための SFRA 設定を示します。SYSCONFIG ペー

ジで Run SFRA アイコンをクリックします。 SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F28P65x の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] ボタンをクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-16 に示すように測定値が表示されたグラフが

表示されます。
10. また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイムスタ

ンプが記録されます。

図 3-13. ADS8588S の CONVST および BUSY 信号
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図 3-14. ラボ 1 [Expression] ウィンドウ、開ループ

Small Duty 

Cycle 2% to 4%

GND

Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCIout

図 3-15. 開ループ電流制御用の SFRA 設定
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図 3-16. 電流制御の開ループ周波数応答

3.4.3 ラボ 2.閉ループ電流制御単相

3.4.3.1 ラボ 2 のソフトウェア オプションの設定

1. このラボを実行するには、前のセクション、図 3-9 で説明したようにハードウェアが設定されていることを確認します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 2: Closed Loop CC Single Channel] を選択します。
• チャンネルを選択します。

• SFRA をイネーブルにします。

• [Run Compensation Design] ボタンをクリックして、Compensation Designer  を開きます。

• 補償デザイナが起動し、有効な SFRA データ ファイルを選択するように求められます。ラボ 1 の実行から補償デ

ザイナに SFRA データをインポートし、2 極、2 ゼロの補償器を設計します。この設計の繰り返し中により多くのマ

ージンを確保して、ループが閉じたときにシステムが安定するようにします。
• 電流ループの補償パラメータを、図 3-18 に示します。

• [Save Comp] ボタンをクリックして、補償を保存します。Compensation Designer ツールを閉じます。

• SYSCONFIG ページを保存します。

4. powerSUITE 以外のバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで

直接変更されます。 Compensation Designer は、

C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils に配置されています。

#define LAB_NUMBER (2)
#define CHANNEL_NUMBER (1)
#define SFRA_ENABLED (true)
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図 3-17. ラボ 2 のビルド オプション
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図 3-18. Compensation Designer を使用した電流ループのチューニング

3.4.3.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 
2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. [Run] → [Debug] をクリックしてデバッグ セッションを開始します。

5. するとプロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_chX.js スクリプト ファイルを参照します。 これにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効

にします。 

3.4.3.3 コードの実行

ラボ 2 のコードを実行するには、次の手順に従います。

1. このラボを実行するには、セクション 3.3.2 で説明したようにハードウェアが設定されていることを確認します。

2. メニュー バーの をクリックしてプロジェクトを実行します。

3. [Watch] ビューの [Expression] ウィンドウで BT4CH_InputVoltageSense_V が 12V～15V の範囲内にあるか

どうかを確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_chX->iref_A を 15.0 に設定します。

• BT4CH_userParam_chX->en_bool を 1 に設定します。
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• [Expression] ウィンドウの設定については、図 3-19 を参照してください。

5. BT4CH_measureVI_chX 変数は、DC/DC コンバータの出力電流と電圧を示します。Isense1_A の表示値は 

iref_A 設定に近く、誤差は ±1mA です。

6. ループ安定性をテストするための SFRA を 図 3-20 に示します。SYSCONFIG ページで Run SFRA アイコンをクリ

ックします。 SFRA GUI がポップアップ表示されます。

7. SFRA GUI でデバイスのオプションを選択します。たとえば、F28P65x の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] ボタンをクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

8. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-21 に示すように測定値が表示されたグラフが

表示されます。
9. また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイムスタ

ンプが記録されます。

図 3-19. ラボ 2 [Expression] ウィンドウ、閉ループ
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図 3-20. 閉ループ電流制御の SFRA 設定

図 3-21. 電流制御の閉ループ周波数応答

3.4.4 ラボ 3.開ループ電圧制御 1 チャネル

3.4.4.1 ラボ 3 のソフトウェア オプションの設定

1. 図 3-9 に示すようにテスト設定を使用します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 3: Single Channel Open-Loop CV Control] を選択します。
• チャンネルを選択します。

• SFRA をイネーブルにします。

• ページを保存します。
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4. powerSUITE 以外のバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで直接

変更されます。 

#define LAB_NUMBER (3)
#define CHANNEL_NUMBER (1)
#define SFRA_ENABLED (true)

図 3-22. ラボ 3 のビルド オプション

3.4.4.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 
2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_chX.js スクリプト ファイルを参照します。 これにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効

にします。 

3.4.4.3 コードの実行

ラボ 3 のコードを実行するには、次の手順に従います。

1. セクション 3.3.2 に示すようにテスト設定を使用します。
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2. メニュー バーの をクリックしてプロジェクトを実行します。

3. [Watch] ビューの [Expression] ウィンドウで BT4CH_InputVoltageSense_V が 12V～15V の範囲内にあるか

どうかを確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_V_I_chm->iref_A を 15.0 に設定します。

• BT4CH_userParam_chX->en_bool を 1 に設定します。

• [Expression] ウィンドウの設定については、図 3-23 を参照してください。

5. BT4CH_measureVI_chX 変数は、DC/DC コンバータの出力電流と電圧を示します。Ibatsense_A の表示値は 

iref_A 設定に近く、誤差は ±1mA です。

6. 図 3-24 に、開ループ電圧制御周波数応答を測定するための SFRA 設定を示します。

7. SYSCONFIG ページで Run SFRA アイコンをクリックします。 SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F28P65x の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] ボタンをクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] ボタンをクリックして、SFRA 掃引を開始できるようになり

ました。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-25 に示すように測定値が表示されたグラ

フが表示されます。
10. また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイムスタ

ンプが記録されます。
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図 3-23. ラボ 3 [Expression] ウィンドウ、閉ループ
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図 3-24. 開ループ電流制御の SFRA 設定
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図 3-25. 電圧制御の開ループ周波数応答

3.4.5 ラボ 4.閉ループ電流および電圧制御 1 チャネル

3.4.5.1 ラボ 4 のソフトウェア オプションの設定

1. 図 3-9 に示すようにテスト設定を使用します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 4: Single Channel Closed-Loop CV] を選択します。
• チャネルを選択します。

• SFRA をイネーブルにします。

• ページを保存します。

4. powerSuite のないバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで

直接変更されます。

#define LAB_NUMBER (4)
#define CHANNEL_NUMBER (1)
#define SFRA_ENABLED (true)
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図 3-26. ラボ 4 のビルド オプション
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図 3-27. Compensation Designer を使用した電圧ループのチューニング

3.4.5.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 
2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_chX.js スクリプト ファイルを参照します。これにより、[Watch] ウィンドウに、シス

テムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効

にします。 

3.4.5.3 コードの実行

ラボ 4 のコードを実行するには、次の手順に従います。

1. セクション 3.3.2 に示すようにテスト設定を使用します。

2. メニュー バーの をクリックしてプロジェクトを実行します。

3. [Watch] ビューの [Expression] ウィンドウで BT4CH_InputVoltageSense_V が 12V～15V の範囲内にあるか

どうかを確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_chX->iref_A を 25.0 に設定します。

• BT4CH_userParam_chX->vrefCharge_V を 0.12 に設定します。
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• BT4CH_userParam_chX->en_bool を 1 に設定します。

• [Expression] ウィンドウの設定については、図 3-28 を参照してください。

5. BT4CH_measureVI_chX 変数は、DC/DC コンバータの出力電流と電圧を示します。Vbatsense_V の表示値が 

vrefCharge_V に近く、誤差は ±0.5mV です。

6. 図 3-29 に、閉ループ電圧制御周波数応答を測定するための SFRA 設定を示します。

7. SYSCONFIG ページで Run SFRA アイコンをクリックします。 SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F28P65x の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] ボタンをクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] ボタンをクリックして、SFRA 掃引を開始できるようになり

ました。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-30 に示すように測定値が表示されたグラ

フが表示されます。
10. また、周波数応答データは SFRA データ フォルダ下のプロジェクト フォルダに保存され、SFRA 実行時のタイムスタ

ンプが記録されます。

図 3-28. ラボ 4 [Expression] ウィンドウ、閉ループ
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図 3-29. 閉ループ電流制御の SFRA 設定

図 3-30. 電圧制御の閉ループ周波数応答

3.4.6 ラボ 5.閉ループ電流および電圧制御 4 チャネル

3.4.6.1 ラボ 5 のソフトウェア オプションの設定

1. 図 3-11 に示すようにテスト設定を使用します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 5: Closed-Loop CCCV Dual Phase] を選択します。
• すべてのチャネルをイネーブルにします。

• [SFRA Enable/Disable] を [1] に設定します。

• ページを保存します。

4. powerSuite のないバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで

直接変更されます。

#define LAB_NUMBER (5) #define
                        CHANNEL_NUMBER (5) #define SFRA_ENABLED (true)
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図 3-31. ラボ 5 のビルド オプション

3.4.6.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。 プロジェクトが正常にビルドされます。Project 
Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

2. 次に、[Run] → [Debug] をクリックしてデバッグ セッションを起動します。 するとプロジェクトがデバイスにロードさ

れ、CCS デバッグ ビューが有効になります。メイン ルーチンの開始時にコードは停止します。

3. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェクト 

フォルダ内にある setupdebugenv_chAll.js スクリプト ファイルを参照します。 これにより、[Watch] ウィンドウに、シ

ステムをデバッグするのに必要な適切な変数が入力されます。

4. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効

にします。 

3.4.6.3 コードの実行

ラボ 5 のコードを実行するには、次の手順に従います。

1. セクション 3.3.2 に示すようにテスト設定を使用します。

2. メニュー バーの をクリックしてプロジェクトを実行します。

3. [Watch] ビューの [Expression] ウィンドウで BT4CH_InputVoltageSense_V が 12V～15V の範囲内にあるか

どうかを確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_chX->iref_A を 5.0 に設定します。

• BT4CH_userParam_chX->vrefCharge_V を 4.2 に設定します。

• BT4CH_userParam_chX->en_bool を 1 に設定します。

• [Expression] ウィンドウの設定については、図 3-28 を参照してください。

5. BT4CH_measureVI_chX 変数は、DC/DC コンバータの出力電流と電圧を示します。

6. Iref と Vref を変更して、定電流モードと定電圧モードの間の遷移を確認します。

7. 電流現在の方向を変更するには、BT4CH_userParam_chX -> Dir_bool を切り替えます。
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3.4.7 較正

1. このラボを実行するには、図 3-11 で説明したようにハードウェアが設定されていることを確認します。ゲイン誤差とオ

フセット誤差のキャリブレーションには、2 点較正法を使用します。

2. 電流を測定するには、外付けの高精度抵抗と DMM を使用するか、E-Load 電流測定値を使用します。または、

TIDA-010090 基板上のセンス抵抗の両端の電圧を使用して、出力電流を測定できます。電圧を測定するには、降

圧コンバータの出力電圧とリモート センス接続の間に DMM を使用します。

3. SYSCONFIG ページを開き、ラボ 5 を選択し、[Calibration Mode] を [Current Calibration] に設定します。 図 3-32 
に、電流キャリブレーションの SYSCONFIG ページの設定を示します。

• SYSCONFIG ページを保存し、コードを実行します。

• [Expression] ウィンドウを開きます。

• 出力電流は、BT4PH_userParam_V_I_chX->ibatCal_pu パラメータを使用して更新します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_chX->en_bool = 1 を設定します。

• BT4CH_userParam_chX->ibatCal_pu を「0.05」および「0.3」に設定し、出力電流読み取り値を書き留めます。

• bt4ch_gan_cal.h ファイルの実際の出力電流読み取り値を更新します。

#define BT4CH_IBAT_ACTUAL_CH1_P1_A ((float32_t)2.5)
#define BT4CH_IBAT_ACTUAL_CH1_P2_A ((float32_t)15.00)

• チャネル 2、3、4 について、この手順を繰り返します。

4. SYSCONFIG ページを開いてラボ 5 を選択し、[Calibration Mode] を [Voltage Calibration] に設定します。 図 

3-33 に、電圧キャリブレーションの SYSCONFIG ページの設定を示します。

• SYSCONFIG ページを保存し、コードを実行します。

• [Expression] ウィンドウを開きます。

• 出力電流は、BT4PH_userParam_V_I_chX->vbatCal_pu パラメータを使用して更新します。

• BT4CH_userParam_chX->Relay_ON を 1 に設定して、出力リレーをイネーブルにします。

• BT4CH_userParam_chX->en_bool = 1 を設定します。

• BT4CH_userParam_chX->vbatCal_pu を「0.2」および「0.6」に設定し、出力電流の測定値を書き留めます。

bt4ch_cal.h ファイルの実際の出力電流読み取り値を更新します。

#define BT4CH_VBAT_ACTUAL_CH1_P1_V ((float32_t)1.195)
#define BT4CH_VBAT_ACTUAL_CH1_P2_V ((float32_t)3.589)

• チャネル 2、3、4 について、この手順を繰り返します。

5. SYSCONFIG ページを開き、キャリブレーション モードをディセーブルにします。

6. powerSUITE 以外のバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで

直接変更されます。 電流キャリブレーションの場合は CALIBRATION_MODE を 1 に設定し、電圧キャリブレーショ

ンの場合は 2 に設定します。

#define LAB_NUMBER (5)
#define CHANNEL_NUMBER (5)
#define CALIBRATION_ENABLED (true)
#define CALIBRATION_MODE (1)
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図 3-32. 電流キャリブレーションのビルド オプション 図 3-33. 電圧キャリブレーションのビルド オプション

3.5 テスト結果

3.5.1 電流ループ負荷レギュレーション

表 3-2. 充電モード負荷レギュレーション

FSR (A) 50

出力モード 充電 放電中

TIDA_010090
ISET (A) 0.1 1 10 25 0.1 1 10 25

ELOAD CV モード 電流センス抵抗で測定される電流

VSET (V) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A)
1.0 0.101 1.000 9.999 24.998 0.099 1.000 9.996 24.994

2.0 0.101 1.000 9.9984 24.997 0.099 0.998 9.996 24.993

3.0 0.1 1.001 9.9984 24.9966 0.098 0.998 9.997 24.994

4.0 0.101 1.001 10.000 24.997 0.1 0.999 9.996 24.993

誤差 (mA) 1 1 1.6 3.4 2 2 4 7

誤差 (% FSR) 0.002 0.002 0.0032 0.0068 0.004 0.004 0.008 0.014

www.ti.com/ja-jp ハードウェア、ソフトウェア、テスト要件、テスト結果

JAJU959 – NOVEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

4 チャネル、50A、デジタル制御バッテリ セル テスタのリファレンス デザイン 33

English Document: TIDUF87
Copyright © 2024 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU959
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU959&partnum=TIDA-010090
https://www.ti.com/lit/pdf/TIDUF87


3.5.2 電流ループ直線性テスト
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図 3-34. 電流ループ直線性テスト

3.5.3 電圧ループ直線性テスト
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図 3-35. 電圧ループ直線性テスト
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3.5.4 DCM のスタートアップ

図 3-36. 5A スタートアップ時の過渡応答

図 3-37. 10A スタートアップ時の過渡応答
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3.5.5 双方向電流スイッチング時間

図 3-38. 充電から放電の過渡応答

図 3-39. 放電から充電の過渡応答
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3.5.6 熱性能

図 3-40 に、2 つのチャネルが 20A をソースし、他の 2 チャネルが 20A をシンクする場合のリファレンス デザインの熱画

像を示します。この測定では、チャネル 1 をチャネル 2 と、チャネル 3 をチャネル 4 と短絡しています。

図 3-40. 熱画像
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4 設計とドキュメントのサポート

4.1 デザイン ファイル

4.1.1 回路図

回路図をダウンロードするには、TIDA-010090 の設計ファイルを参照してください。

4.1.2 BOM

部品表 (BOM) をダウンロードするには、TIDA-010090 の設計ファイルを参照してください。

4.2 ツールとソフトウェア

ツール

TMDSCNCD28P65X TSM320F28P65x controlCARD 評価基板

ソフトウェア

CCSTUDIO Code Composer Studio (CCS) 統合開発環境 (IDE)
C2000WARE-DIGITALPOWER-SDK C2000™ マイコン向け DigitalPower ソフトウェア開発キット (SDK)

4.3 ドキュメントのサポート

1. テキサス・インスツルメンツ、『TMS320F28P65x リアルタイム マイクロコントローラ データ シート』

2. テキサス・インスツルメンツ、『ADS8588S 16 チャネル、高速、8 チャネル、同時サンプリング ADC、単一電源による

バイポーラ入力』データシート 

4.4 サポート・リソース

テキサス・インスツルメンツ E2E™ サポート・フォーラムは、エンジニアが検証済みの回答と設計に関するヒントをエキスパ

ートから迅速かつ直接得ることができる場所です。既存の回答を検索したり、独自の質問をしたりすることで、設計で必要
な支援を迅速に得ることができます。

リンクされているコンテンツは、各寄稿者により「現状のまま」提供されるものです。これらはテキサス・インスツルメンツの仕
様を構成するものではなく、必ずしもテキサス・インスツルメンツの見解を反映したものではありません。テキサス・インスツ
ルメンツの使用条件を参照してください。

4.5 商標

C2000™, テキサス・インスツルメンツの™, and Code Composer Studio™, and テキサス・インスツルメンツ E2E™ are 
trademarks of Texas Instruments.
すべての商標は、それぞれの所有者に帰属します。

5 著者について

SHAURY ANAND は、 テキサス・インスツルメンツのシステム エンジニアであり、テストおよび測定アプリケーションのリフ

ァレンス デザイン開発を担当しています。インド工科大学ローキー校で電気工学の学士号 (B.Tech) を取得しています。

このリファレンス デザインへのサポートについて、 JINGQUAN ZHU、ETHAN YU、SEN WANG、OZINO ODHARO、

TIM PRICE に感謝します。
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重要なお知らせと免責事項
テキサス・インスツルメンツは、技術データと信頼性データ (データシートを含みます)、設計リソース (リファレンス デザインを含みます)、アプリケーショ

ンや設計に関する各種アドバイス、Web ツール、安全性情報、その他のリソースを、欠陥が存在する可能性のある「現状のまま」提供しており、商品性

および特定目的に対する適合性の黙示保証、第三者の知的財産権の非侵害保証を含むいかなる保証も、明示的または黙示的にかかわらず拒否しま
す。

これらのリソースは、 テキサス・インスツルメンツ製品を使用する設計の経験を積んだ開発者への提供を意図したものです。(1) お客様のアプリケーショ

ンに適した テキサス・インスツルメンツ製品の選定、(2) お客様のアプリケーションの設計、検証、試験、(3) お客様のアプリケーションに該当する各種

規格や、その他のあらゆる安全性、セキュリティ、規制、または他の要件への確実な適合に関する責任を、お客様のみが単独で負うものとします。

上記の各種リソースは、予告なく変更される可能性があります。これらのリソースは、リソースで説明されている テキサス・インスツルメンツ製品を使用す

るアプリケーションの開発の目的でのみ、 テキサス・インスツルメンツはその使用をお客様に許諾します。これらのリソースに関して、他の目的で複製す

ることや掲載することは禁止されています。 テキサス・インスツルメンツや第三者の知的財産権のライセンスが付与されている訳ではありません。お客様

は、これらのリソースを自身で使用した結果発生するあらゆる申し立て、損害、費用、損失、責任について、 テキサス・インスツルメンツおよびその代理

人を完全に補償するものとし、 テキサス・インスツルメンツは一切の責任を拒否します。

テキサス・インスツルメンツの製品は、 テキサス・インスツルメンツの販売条件、または ti.com やかかる テキサス・インスツルメンツ製品の関連資料など

のいずれかを通じて提供する適用可能な条項の下で提供されています。 テキサス・インスツルメンツがこれらのリソースを提供することは、適用される 

テキサス・インスツルメンツの保証または他の保証の放棄の拡大や変更を意味するものではありません。

お客様がいかなる追加条項または代替条項を提案した場合でも、 テキサス・インスツルメンツはそれらに異議を唱え、拒否します。IMPORTANT 
NOTICE
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重要なお知らせと免責事項
TI は、技術データと信頼性データ (データシートを含みます)、設計リソース (リファレンス・デザインを含みます)、アプリケーションや
設計に関する各種アドバイス、Web ツール、安全性情報、その他のリソースを、欠陥が存在する可能性のある「現状のまま」提供してお
り、商品性および特定目的に対する適合性の黙示保証、第三者の知的財産権の非侵害保証を含むいかなる保証も、明示的または黙示的に
かかわらず拒否します。
これらのリソースは、TI 製品を使用する設計の経験を積んだ開発者への提供を意図したものです。(1) お客様のアプリケーションに適した 
TI 製品の選定、(2) お客様のアプリケーションの設計、検証、試験、(3) お客様のアプリケーションに該当する各種規格や、その他のあら
ゆる安全性、セキュリティ、規制、または他の要件への確実な適合に関する責任を、お客様のみが単独で負うものとします。
上記の各種リソースは、予告なく変更される可能性があります。これらのリソースは、リソースで説明されている TI 製品を使用するアプ
リケーションの開発の目的でのみ、TI はその使用をお客様に許諾します。これらのリソースに関して、他の目的で複製することや掲載す
ることは禁止されています。TI や第三者の知的財産権のライセンスが付与されている訳ではありません。お客様は、これらのリソースを
自身で使用した結果発生するあらゆる申し立て、損害、費用、損失、責任について、TI およびその代理人を完全に補償するものとし、TI
は一切の責任を拒否します。
TI の製品は、TI の販売条件、または ti.com やかかる TI 製品の関連資料などのいずれかを通じて提供する適用可能な条項の下で提供され
ています。TI がこれらのリソースを提供することは、適用される TI の保証または他の保証の放棄の拡大や変更を意味するものではありま
せん。
お客様がいかなる追加条項または代替条項を提案した場合でも、TI はそれらに異議を唱え、拒否します。IMPORTANT NOTICE
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